
 

 

www.AdvancedSolutions.com                                                                             

 

Simulate While You Design with Inventor and Simulation DFM 
Robert Savage – Advanced Solutions Inc., Education Specialist - Primary Speaker 

Kevin J. Smedley – FS-Elliott Co., LLC – Co-Speaker  

 

MD5511 Simulation DFM or “Design for Manufacturing” software was created by Autodesk after 

they purchased Moldflow. It was inspired by a Moldflow software called “Moldflow Cad Doctor”, but DFM 

is not a Moldflow product… It is, however, powered by Moldflow. It was created to be used by designers 

and engineers to help verify the part design and cut down on costly mistakes at the part level. DFM loads 

inside your 3D design tool to give you near-real-time feedback on the quality of your plastic part, as you 

design it. Simulation DFM software reviews things, such as nominal wall thickness, draft angle, material 

cost, part recyclability, sink marks, fill patterns, and more, to grade your part in the categories of 

manufacturability, cost, and environmental impact. In this class, we will look at how we can analyze the 

part files, during the design process. We will also investigate the effect changes to the configurations and 

the parts have.    

Learning Objectives 
At the end of this class, you will be able to: 

1. Learn how to navigate the Simulation DFM interface 
2. Learn how to analyze the model for possible defects 
3. Learn how to make changes to the model's material 
4. Review cost effects of part changes 

About the Speakers 
Robert Savage is an Education Specialist at Advanced Solutions, Inc. He is a 15-year design veteran who 

has designed everything from molds and molded parts to robots. At Remotec, a division of Northrop 

Grumman Corporation, he spent 5 years as a designer in the development group, as well as CAD and Vault 

Administrator. He is an Autodesk Certified Instructor and a Certified Inventor Professional. He has used 

Inventor software since its inception, as well as being well-versed in a variety of other design software. He 

has 10 years of experience teaching 3D design software, including Product Design Suite Ultimate software, 

Factory Design Suite Ultimate software, Simulation Moldflow software, and Vault Professional software. 

Email: rsavage@advancedsolutions.com   
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Kevin Smedley is currently Cad Manager for Product Engineering at FS-Elliott Company, a Global 

Centrifugal Compressor Manufacturer with facilities in Asia, Europe, South America and headquartered in 

Export, Pennsylvania. He has 26 years of Autodesk applications experience in design/drafting and as an 

Autodesk VAR channel Technical/Mechanical Applications Engineer. He spent 16 years, in the Autodesk 

channel, implementing 3D processes and creating Vault database strategies, along with training users. 

Kevin has created best practices and workflows, as a Certified Inventor and Vault Specialist. He’s presented 

lectures and hands-on labs at Autodesk University for 7 years, as well as attending AU for 10 years. Kevin’s 

philosophy is summed up in three words… Communication, Consistency, and Standards. Kevin continues 

pursuing best practices and processes for the Product Design Suite and Vault Pro data management. 

Email: ksmedley@fs-elliott.com  
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Chapter 1 

Navigate the Interfaces 
 Widget 

 Standalone 

 

Simulation DFM (Simulation Design for Manufacturing) is part of the Autodesk Digital Prototyping solutions. 

Simulation DFM also runs as a standalone tool and as a widget inside your Autodesk Inventor software. In 

addition, it will work in PTC Creo, and Solidworks. Simulation DFM is designed to show real-time evaluation 

of your plastic components, focusing on Manufacturability, Cost Efficiency, and Plastic Material Impact. It 

is intended to be used during the 3D part design process by both designers and engineers to minimize 

errors and improve design efficiencies. The widget uses 

green/yellow/red indicators for visual feedback in areas, 

such as wall thickness, draft angles, sink marks, fill 

patterns, and part recyclability.  As the design process 

builds, the DFM evaluates and updates the output. 

Autodesk has a portfolio of Simulation products which fits into a number of different situations.  The portfolio 

make up includes the following: 

Mechanical Simulation 

 

 

Moldflow Simulation 

   

Composite Simulation 

  

Computational Fluid Dynamics Simulation 

  

 



Simulate While You Design with Inventor and Simulation DFM 

 

 
 

Structural Analysis 

 

Widget 

Simulation DFM will run as a widget inside Autodesk Inventor, as well as PTC Creo, and 

Solidworks, giving the same analysis for each of the products. The widget is similar to a toolbar, 

but instead of icons, it has indicators that change colors from Green to Yellow to Red, showing 

the severity of the issue. In this class, we are going to be focusing on using DFM, while running 

Inventor software. It can be set to load automatically in the software by going to the Tools Tab 

then selecting the Add-Ins Button. Inside the Add-In Manage, you can set Autodesk Simulation 

DFM to Load/Unload or Load Automatically.  

The Widget has 3 main parts: the Indicators, the Menu, and the Refresh Button. The Widget 

Indicator displays the results of the analysis in the 3 different categories: Manufacturability, Cost 

Efficiency, and Plastic Material Impact.  

The Widget Menu is a dropdown menu in the lower right hand corner of the page. In the drop 

down, you will find the options and toolbars for defining injector locations and Fill Animation, as 

well as A Finish Part Previewer. The Refresh tool, which can be set to automatically refresh, will 

show as a button in the upper left hand corner of the tools. The Refresh tool is what you would 

select to tell it to refresh your calculations. 

If an indicator has a yellow triangle with an exclamation mark on it, you have received an Alert. 

This means you have one or more subcategories with an issue, which you need to address. If 

you select on the indicator, it will display the subcategory with the issue. If you select the 

subcategory, it will then display the issue on the model.  

Indicators 

 

            Plastic Material Impact 

      Cost Efficiency 

            Manufacturability 
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Menu 

 

Refresh 

The Refresh can be used as an Automatic Refresh by checking the option in the dropdown list 

on the widget, or used as a manual refresh to be selected as desired. 
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Toolbars 

There are 2 toolbars available in the dropdown menu on the widget. They are named, “Injection 

location” and “Animation”. In the software, they display as toolbars. However, in the standalone 

they show up as tabs in the ribbon.  

 

 Injection location 

 Animation (Fill Animation) 
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Standalone 
 

Simulation DFM will not only run inside of a variety of design software, but it also runs as a 

standalone where it will read and analyze 11 different file formats. The standalone will run the 

same tools as the add-on software. In the standalone, you have the same tools as the widget, 

but you have an increase in file formats that you can work with. 

 

It also contains 2 different ways of using the tools. You can choose to use the widget or the 

ribbon to access the different tools. 
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Chapter 2 

Analyzing the Model 
 Indicators 

o Manufacturability 

o Cost Efficiency 

o Plastic Material Impact 

 Pull Direction 

 Fill Tools 

 Injector Locations 

 Finished Part Preview 

 Exporting Results 

In this Chapter, we are going to focus on how the tools are used to analyze your design. The 

tools are used the same, whether you are using the Widget or the Standalone tools. The 

Indicator tools will give you visual feedback on the thresholds that are configured in the system. 

The toolbars will allow you to set injector locations and view the fill results based on the injector 

locations.  

 

Indicators  

o Manufacturability 

o Cost Efficiency 

o Plastic Material Impact 

Manufacturability, Cost Efficiency, and Plastic Material Impact are indicators on the widget, but 

they are rollups of different subcategories. They indicate the overall effect of the different 

subcategories by using different colors. By selecting the indicator, it will list the subcategories 

that are not at optimal levels in the alerts section and all levels will be listed in the information 

section. 
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There are 3 buttons in the Indicators. They each have different areas they are evaluating. The 

button changes colors from green to yellow to red, and if you put your cursor over the indicator it 

will give you an overall percentage of the cumulative subcategories. If you select the indicator, 

you will get a drop down that has two tabs: Alerts and Information. In the Alerts area, you will 

see any subcategory that has a higher chance of causing an issue in manufacturing. Selecting a 

subcategory will also highlight the areas on the screen where the issue exists. 
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The Information tab will let you see the results from all of the sub categories. Selecting a 

subcategory will either giving you an on-the-screen representation of the issues, or a dialog box 

indicating why the rating is not high. 

 

 

In the design software, the Indicators and subcategories recalculate, as you make modifications 

to the model or when you tell it to refresh.  Unless, you have it set to Auto-refresh.  
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Animation Tools 

The Animation tool will play, pause, and replay the fill animation, based on the injector locations. 

This can be used with the Injector tools to see how the part will fill. These tools are used 

together to determine results, like, Weld Lines and Sink Marks. 
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Pull Direction 

The Pull Direction is a tool that is only available in the standalone. The icon for the tool launches 

a tab on the ribbon, allowing you to define or move the pull direction of the part. It launches a 

triad that you can place and adjust, by making adjustments to the Red, Green or Blue circular 

rings. 
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Injection Locations 

The Injection Locations tool will allow you to Move, Add and Delete Injector Locations. There is, 

by default, 1 injector placed by Simulation DFM that is used in several of the calculations. By 

moving or adding locations, it will prompt the software to redo the calculations and change the 

results. 
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Finished Part View 

The Finished Part View tool is located in the dropdown list on the Widget and the Ribbon on the 

standalone. It generates a rendered view of the part to help show any defects that may be 

caused by fill or weld line issues. Inside the rendered window, you can make adjustments to the 

material under the Edit drop down menu and highlight the defects under the view dropdown. 

You can also save the file out as an image file under the File dropdown. 
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Saving and Exporting 

When you save the file in Inventor, any adjustments you make to the DFM portion of the file is 

saved, so that the next time you open the file the changes are still there. If you have the 

software, you can also export the information to the Autodesk MoldFlow. 

 

 

My Analysis Process 

In this section, I want to go through the DFM Analysis process I use on plastic parts. Every part 

is different, as is every user. That is why this is intended as a general process guideline. 

1. Open or create the file to the point that you are ready to start analyzing it. 

2. Update or turn on automatic updates. 

3. Review manufacturability alerts and information. 

4. Check your fill location or locations.  

5. Make necessary changes to the part. 

6. Repeat 3 and 4 till you have it the way you want it. 

7. Review cost and material alerts and information to see if changes are needed. 

8. Run finish part preview. 

9. Save and export if needed. 
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Chapter 3 

Making Changes 
 Configure Rules 

 Materials 

 

In this section, we are going to look at the different areas you can configure to changes the 

results that DFM displays in the indicators. We are also going to see how to change materials 

and what affect the material changes have to the results. 

Configure Rules 

The Configuration Rules can be accessed from the drop down menu on the widget or the ribbon 

in the standalone. In the rules configuration area, you can select what rules affect the indicators. 

In the sub categories, you can adjust the percentages displayed in the indicator. 

Note: 

 Modifications to the configuration will apply to all parts  
 Not all parameters can be configured 
 Because an indicator result is a combination of several parameters, the effect of altering a 

parameter may not be obvious 
 Realistic parameter values need to be applied  
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In the rule configuration dialog box, you can adjust what calculations are included in the 

indicators by checking or unchecking the rule in the main indicator headers. 

  

Manufacturability: Wall Thickness calculates the percentage above and below the median wall 

thickness. 

 

Manufacturability: Undercuts calculate the percentage of undercuts to total surface. 
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Manufacturability: Draft Angle calculates a percentage of drafted faces, based on a defined 

minimum draft angle. 

 

 
Manufacturability: Weld Lines will check weakness and visual flaws caused by joining flow. 

 

Manufacturability: Sink Mark checks for surface depressions. 
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Manufacturability: Filling calculates fill ability, based on pressure location and wall thickness. 

 

 
Manufacturability: Knife Edge (New in the 2015 software version) allows you to define a 

minimum thin edge. 

 

 

Cost Efficiency: Mold Cost is based on size and complexity of the mold tooling. 
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Cost Efficiency: Material Cost calculates raw material cost and volume. 

 

 

Cost Efficiency: Production Cost is based on cycle times. 

 

 

Plastic Material Impact: Carbon Footprint calculates the carbon dioxide required to produce 

each. 
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Plastic Material Impact: Embodied Energy calculates the energy in BTU’s required to make 

each part. 

 

Plastic Material Impact: Recyclability calculates material recycle rate. 

 

 

Plastic Material Impact: Embodied Water calculates the water required to produce the part. 
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If you have a threshold you want to meet, most of these allow you to add or append the 

percentages. 

 

You also have a button at the bottom of the page that will “Restore All Defaults”. 

 

 

Materials 

Material is changed differently in the standalone verses the widget in Inventor. In the widget 

(Inside Autodesk Inventor), the material is changed in the same way you would for any other 

part. You can change it using the physical tab, in the part iProperties, or the material drop down 

menu on the ribbon. Both of these options use the Autodesk Materials Library. 
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In the standalone, you would use the Select Material tool on the Home tab of the ribbon. In the 

Material selection box, materials are listed by name, as well as by common uses. It also 

displays a cost indicator and plastic material impact indicator. You can sort the materials by 

Application and Attributes, using the drop down list at the top of the box. 
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Chapter 4 

Cost Effect of Part Changes 
 Mold Cost 

 Material Cost 

 Production Cost 

In this section, we are going to look at how cost effect is determined based on three main 

categories: Mold Cost, Material Cost, and Production Cost. There is no true way for the software 

to calculate the actual cost of the mold, the material, or the production of the part. What it does 

is display the Cost Efficiency as a percentage of the three categories. These calculations adjust 

with every effected change made to the part, both physical and material. 

 

Mold Cost 

Mold Cost checks the size and complexity of the mold tooling. As you make changes to the 

parts to reduce size and complexity, the system will automatically recalculate and adjust. 
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Material Cost 

The Material Cost is based on part size and raw material cost. As you adjust the model size or 

material, whether it is in the CAD software or in the standalone application, it will adjust the 

calculations. 

 

Production Cost 

Production Cost is based on Part Cycle Time, which is based on material properties, injector 

quantities and fill pattern. 
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Conclusion 

Simulate While You Design with Inventor and Simulation DFM 
 Learn how to navigate the Simulation DFM interface 

 Learn how to analyze the model for possible defects 

 Learn how to make changes to the model's material 

 Review cost effects of part changes 
 

In this class, we looked at using Simulation DFM inside of Inventor and as a standalone, to 

improve the design process of creating plastic parts. Simulation DFM is an analysis tool that 

allows you to see the effect different variables have on the overall manufacturability of a part. 

You can also see real-time updates on how changes to the file and material effect the overall 

manufacturability of the part.  

In Chapter 1, we went through the interface of both the widget that runs inside of Inventor, as 

well as the standalone interface. We also looked at the different areas in the interface and what 

they mean. 

In Chapter 2, we explored the different analysis tools that exist within the software and how to 

apply them to the model. 

In Chapter 3, we talked about the effect changes to the rules, as well as the material, have on 

the calculations. 

In Chapter 4, we looked at how the cost effect was calculated and how changes effect the 

results of the calculations. 

I want to thank you for attending this class. I know you have a lot of class choices at AU2015. If 

you have any questions on the information, please feel free to email me at 

rsavage@advancedsolutions.com.  

I would also like to thank Kevin Smedley for his assistance in this class. He not only kept me on 

track, but on point. 
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